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CAESAR II® README 
Product: CAESAR II 

Version: 14 (14.00.00) 

Date: December 2023 

Description: CAESAR II is the industry leading pipe stress analysis program that evaluates 
the structural responses and stresses of piping systems according to 
international codes and standards. 

Sections: System Requirements 
Version Compatibility 
Special Instructions 
Documentation 
Training 
Customer Support 
New Features in this Version 
Fixes 
Legal Notices 

System Requirements 

 Beginning with Windows 10, Microsoft enforces the Internet Host Table 

Specification RFC 952, which mandates that component hostname labels can contain only 

alphanumeric characters. Hostnames using underscores (‘_’) are not allowed. Refer to Microsoft 

KB 101785. 

CAESAR II® meets the applicable requirements of Intergraph Smart® Enterprise Platform 2023. 

 The operating system compatibility details that follow refer to the latest released version 

of this software. Previous versions of the software may not work with newer operating systems. 

Operating System Compatibility Information 

Windows 10 21H2 or later 
Professional & Enterprise (64 bit) 

Windows 11 21H2 or later 
Professional & Enterprise (64 bit) 

These operating systems are tested by 

Hexagon. 

Windows Server 2022 
Only tested by Hexagon for the installation of 

network licensing systems. 

Prerequisites 

Microsoft .NET 4.8 or greater 
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Licensing 

Intergraph Smart® Licensing 14.2.1.192 or later 

Hardware 

Processor: 3.0 GHz Intel Pentium IV or higher AMD Athlon dual-core processor or higher 

Memory: 4 GB RAM or higher 

Display: 1280X1024 or higher, with True Color 

Video Card: 512 MB or greater video RAM, Open GL 1.1 or later, DirectX 11.0 or later, drivers 

updated with the latest manufacturer’s drivers (Motherboard-integrated video cards not 

recommended for desktop systems.) 

Remote Technologies 

Citrix XenApp 7.22 required on Windows Server Enterprise 2019 or 2020 

Version Compatibility 

For up-to-date information on the software compatibility of this product in a standalone or 

integrated environment, please refer to the Compatibility Matrix. 

To review compatibility information for this product: 

1. Go to the Compatibility Matrix (https://compatibilitymatrix.hexagonali.com). 

2. Click Product Search. 

3. In the Product list, select the product you want to view compatibility for. 

4. In the Version list, select the version.  

Special Instructions 

CAESAR II is a Windows 10 and 11-based program. The input files created by Version 14 are not 

downward compatible with previous versions. However, Version 14 can read input files from any 

previous version. 

Existing users should install this latest version in a different directory from any earlier existing 

version. CAESAR II displays the version number and build date in the lower right corner of the 

main window for your reference. 

This version of CAESAR II should be started by using C2.EXE. 

When you start the CAESAR II application, you should select or specify a job name (by selecting 

File > New or File > Open) before using any other module. Most of the modules function using the 

current working directory. If this information is not available, the module cannot run. You can select 

File > Set Default Data Directory to save this working directory in the registry. 

  

https://compatibilitymatrix.hexagonali.com/
https://compatibilitymatrix.hexagonali.com/
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Windows Language Pack Considerations 

The CAESAR II language (such as Japanese or Chinese) is not the same as the Windows 

language. You must install a language pack. For more information, see Recommendations for 

Windows 10 users in the Windows support article Why does some text display with square boxes 

in some apps on Windows 10?. 

Post Installation Considerations 

CAESAR II installs the NETUSERC2.BAT batch file in the CAESAR II program directory: If you 

install CAESAR II to a network drive, only the installing workstation has the proper .dll files installed 

and registered. Run this batch file on all other workstations that will run CAESAR II to ensure the 

.dll files are current and registered. 

CAESAR II installs the following batch files in the CAESAR II System directory 

(…\ProgramData\Intergraph CAS\CAESAR II\<version number>\System): 

• ACCESS2010.BAT – Use this batch file to copy the MS Access 2010 template onto the 
active template used by CAESAR II. 

• ACCESS2007.BAT – Use this batch file to copy the MS Access 2007 template onto the 
active template used by CAESAR II. 

• ACCESS2002-2003.BAT – Use this batch file to copy the MS Access 2002-2003 template 
onto the active template used by CAESAR II. If you are using Access 2002/2003 already, 
you do not need to run this batch file. 

• ACCESS2000.BAT – Use this batch file to copy the MS Access 2000 template onto the 
active template used by CAESAR II. If you are running Access 2000, run this batch file to 
use the appropriate template and to avoid having to convert database files individually. 

For more information on installing CAESAR II, refer to the CAESAR II Quick Reference Guide. 

Documentation 

Use the Help menu to access the help for this product. You can also view documentation for this 

product online at Hexagon Documentation (https://docs.hexagonali.com/). 

Printed documentation is not available for separate purchase. 

Training 

To access free eLearning, visit Hexagon University (https://university.hexagonali.com/). 

To register for instructor-led training, call Training Registration at (800) 766-7701 in the U.S. 

Outside the U.S., call (256) 730-5400 or contact your local Hexagon office. 

Customer Support 

For the latest support information for this product, including solutions to known software issues, 

visit Hexagon Support (hexagon.com/support-success/asset-lifecycle-intelligence). 

To open service requests outside the U.S., please contact your local Hexagon office.  

https://support.microsoft.com/en-us/help/3083806/why-does-some-text-display-with-square-boxes-in-some-apps-on-windows-1
https://support.microsoft.com/en-us/help/3083806/why-does-some-text-display-with-square-boxes-in-some-apps-on-windows-1
https://docs.hexagonali.com/
https://university.hexagonali.com/
https://hexagon.com/support-success/asset-lifecycle-intelligence
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New Features in this Version 

Codes and Standards 

Added support for the following piping code editions: 

▪ ASME B31.12 - 2019 Hydrogen Piping and Pipelines, including Part IP Industrial Piping and Part PL 
Pipelines. (2587049) 

▪ ASME B31.1 - 2022 edition (Power Piping). (3610861) 

▪ ASME B31.3 - 2022 edition (Process Piping). (3258941) 

▪ ASME B31.4 - 2022 edition (Pipeline Transportation Systems for Liquids and Slurries). (3710265) 

▪ ASME B31.5 - 2022 edition (Refrigeration Piping and Heat Transfer Components). (3710266) 

▪ ASME B31.8 - 2022 edition (Gas Transmission and Distribution Piping Systems) . (3710267) 

▪ EN-13480-3:2017/A5:2022 (Metallic industrial piping - Part 3: Design and calculation). (3766708) 

▪ API 617 - 2022 edition (9th edition) for equipment analysis. (3393801) 

▪ ASCE 7 - 2022 edition for wind and seismic loads. (3394117) 

▪ IBC - 2021 for edition wind and seismic loads. (3774779) 

Material and Content 

▪ Added fifth working range quadruple springs to the ANVIL hanger tables. Also added spring sizes 000 
and 00 for the B-268 springs. (CR-TX-41601) 

▪ Added the fourth and fifth size springs to the PSSI Group hanger tables. (CR-TX-41633) 

▪ Added hanger tables for Rilco Manufacturing pipe supports. (CR-TX-41600) 

▪ Added 119 material records for B31.12-2019 into the material database. Physical property data is from 
ASME B31.3-2018 and ASME BPVC Section II Part D-2021. Allowable stress data is from ASME B31.12-
2019. (3702385) 

Piping Input 

▪ Updated the Seismic Wizard to support ASCE 7-22 and IBC 2021. (3728042, 3852605) 

▪ Updated the Allowable Stresses auxiliary data tab to support B31.12 Parts IP and PL. (3728041, 
3737557, 3737558) 

▪ Updated Use Alternative Rules for Stress Range Evaluation on the Configuration Editor to support 
B31.12 Appendix B. (3811168) 

Static and Dynamic Analysis 

▪ Updated the Wind Loads tab (Static Analysis - Load Case Editor Dialog) and the DLF/Spectrum 
Generator to support ASCE 7-22 and IBC 2021. (3737461, 3737460, 3852605) 

▪ Enhanced the software to consider the thermal bowing load when you define a value for Thermal 
Bowing Delta Temperature and define an operating temperature that is the same as or close to the 
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Ambient Temperature. A technical discussion for thermal bowing is also added to the help. (287351, 
1068479) 

▪ Piping codes that use ASME B31J can now use the SIF Multiplier for Sustained Stress Index option in 
the Configuration Editor. (3707958) 

▪ Updated the Dynamic Analysis calculations for the B31.4, B31.4 Chapter IX, B31.4 Chapter XI, B31.8, 
and B31.8 Chapter VIII piping codes with multiple offshore and transportation code stresses. The 
changes affect time history analysis and spectrum analysis. (3652875) 

▪ Updated the MDMT calculations to support B31.3-2022 edition. (3860286) 

Equipment 

▪ Updated the API 617 (Centrifugal Compressors) component of Equipment Analysis to allow the 
Allowable Load Multiplier to be greater than 2.0 with manufacturer approval. (2922653) 

▪ Updated the NEMA SM23 (Steam Turbines) component of Equipment Analysis to allow the Allowable 
Load Multiplier to be greater than 2.0 with manufacturer approval. (3030196) 

Output and Reports 

▪ Stress reports for primary stress types (such as SUS, OCC, and HYD) now display sustained intensification 
factors (SSI) for metallic piping codes. (3529918) 

▪ You can now create combined .pdf reports in the Output Viewer Wizard of the Static Output Processor. 
(3779193) 

▪ The length of the company name displayed on output reports has been increased from 34 characters to 
64 characters. (3628083) 

Documentation/Help 

▪ Added a new version of offline help for installations that do not have internet access to the online help. 
Offline help now opens in your default web browser. (3737360) 

▪ Added a technical discussion for thermal bowing. (1068479) 

▪ Added notes to Advanced PCF Import (APCF) and Import PCF about using Unicode UTF-8 when your 
region is set to Asian languages. This allows the proper import of .pcf files containing Asian characters. 
(2677410) 
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Fixes 

Codes and Standards 

▪ Changed the ISO 14692-2005 implementation when a stress type has no envelope. The stress reports 

now display the maximum between hoop stress and longitudinal stress instead of always displaying the 

hoop stress. (791407) 

Material and Content 

▪ Fixed an incorrect EN 10269:1999 material number for X2CrNiMo17-12-2. (TR-TX-35150) 

▪ Fixed incorrect long bend radii variables for ½ and ¾ inch nominal OD pipe. (TR-TX-31070) 

▪ Fixed incorrect gasket diameters for the ASME-2009 and ASME-2009M - Class 900 databases. (TR-TX-

31730) 

▪ Fixed an incorrect elastic modulus value in the B31.5 database. (TR-TX-41796) 

▪ Fixed a small error in the recommended installation clearance for Pihasa spring hangers. (TR-TX-36028) 

Piping Input 

▪ Fixed an issue where block operation renumbering of a PCF-imported model reset coordinates of a 

block to (0,0,0). (TR-TX-40835) 

▪ Fixed an error where the Type list for B31J SIFs & Tees sometimes did not display correctly. (TR-TX-

41869) 

▪ Fixed an issue where the Coordinates list reset to the top of the list after clicking in the graphic view. 

The Coordinates list now sorts in element order instead of node incremental order. (TR-TX-41669) 

▪ Fixed multiple issues involving propagation of inputs in the Allowable Stresses auxiliary tab when using 

ISO 14692 with other piping codes. (TR-TX-25607, TR-TX-32246, TR-TX-36516, TR-TX-36461) 

▪ Fixed an issue with flanges in the NC-3558.3 code where values were required for all flange yield 

strength fields SY1 through SY9 when temperatures T1 through T9 were not defined. (TR-TX-37306) 

▪ Fixed an issue with Set North Direction not displaying the correct axis in Special Execution Parameters 

when switching between files. (TR-TX-36748) 

▪ Fixed an issue where the software incorrectly used FRP type 2 filament as the ISO 14692-2005 default 

for bends. Type 3 is now the correct default. (TR-TX-33372) 

▪ Fixed an issue where elements hidden by Line Number became visible when a legend was displayed. 

(TR-TX-14738) 

▪ Fixed an issue with the Equipment Limits list operations toolbar where clicking in the From Node or To 

Node fields made other fields unavailable. (TR-TX-24674) 

▪ Fixed issues with the status of checkboxes, roundtrip neutral file conversion, the Allowables list, and 

input echo for Hand Lay and Appendix P - OPE Allowable Reduction. (344039) 
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▪ Increased the maximum number of jobs to 200 for Include Structural Input Files. Added a note on the 

number of disconnections allowed for Include Piping Input Files. (3249205) 

▪ Fixed an issue where B31J surface nodes did not renumber when renumbering all nodes. (3695582) 

▪ Fixed an issue with import of Smart 3D/ SmartPlant Review .vue files. (3870011) 

▪ Fixed an issue with importing a CADWorx .dwg file. (3533795) 

▪ Fixed an occasional issue with the display of a Guide due to the incorrect use of CNodes. (2829910) 

▪ Fixed an issue with unreadable small node numbers when printing Piping Input graphics to a .pdf file. 

(2919102) 

Structural Steel Modeler 

▪ Fixed an issue with section properties not updating after selecting a cross-section in the Card Stack. (TR-

TX-34361) 

Static and Dynamic Analysis 

▪ Addressed a weight calculation issue for a specific static analysis load case set containing load cases 

with uniform loads (U1 through U9), the hydrotest load case (HYD), and the WW primitive. The model 

input also specified the insulation thickness and rigid elements, such as valves or flanges. To exclude the 

insulation weight from the total system weight for the hydrotest, the software incorrectly applied the 

uniform load-calculated weight (W) instead of the WW-calculated weight in the HYD load case for rigid 

elements. This caused an error when importing forces and moments from the HYD load case into 

Equipment Analysis modules. (TR-TX-39451) 

▪ Fixed element viewer, time history, animation, and .tout file issues with the dynamic output processor. 

(TR-TX-33044, TR-TX-4700, TR-TX-8565, TR-TX-9496, TR-TX-34157, TR-TX-41631) 

▪ Fixed an issue with incorrect node numbers of a reducer displaying in a D/t ratio warning message for 

the B31.8 and EN 13480 piping codes. (TR-TX-38724) 

▪ Clarified the warning message that displays when you define a negative pressure. (TR-TX-41657) 

▪ For the Stresses (Multiple Code/Allow) Report, the algorithm now uses the combination load cases to 

determine the governing code stress for transportation and offshore piping codes. (TR-TX-32504) 

▪ For ISO 14692 dynamic harmonic analysis, fixed an issue where load cycles, such as occasional loads, 

were not defined and the OCC factor was zero. This prevented harmonic envelope calculations and 

resulted in allowable stresses of zero. (TR-TX-36517) 

▪ For the Stoomwezen code, fixed an issue where the internal mill tolerance was incorrectly initialized to 

zero for reducing tee stress calculations if the mill tolerance was not specified in Piping Input. The 

software now initializes to the Minimum Wall Mill Tolerance (%) value defined in the Configuration 

Editor. (3275115) 

▪ Improved the stress calculations for ISO 14692-2017 to exclude the calculation of ring bending stress 

and roping stress from the algebraic combination load cases. (3202560) 
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▪ Improved the load case deletion algorithm to avoid improper deletion of dependent load cases that are 

marked for modification. (3937966) 

▪ Fixed an issue to automatically apply the Bourdon effect to FRP pipes in the calculation of the limiting 

force for the restrained pipe status. This change affects B31.4, B31.4 Ch. XI, B31.8 , and ISO 14692-2017. 

(4026281) 

▪ Fixed a B31J issue where a surface node was missing from the analysis when two adjacent tees shared 

an element, and the tee definitions were on the shared element. (4077448) 

Isometrics 

▪ Fixed a Generate Stress Isometrics drawings issue of missing or duplicated load case annotations when 

both displacement and restraint annotations were requested at the same time. (3207112) 

▪ Fixed an issue with Generate Stress Isometrics unexpectedly closing for models with node numbers 

longer than five digits. (3974663) 

▪ Fixed an issue with creating isometrics when a model had a tee preceding a bend. (2310418) 

Equipment and Components 

▪ Fixed an incorrect calculation and a resulting error message when importing load cases into the EN-

1591 Flanges module. (TR-TX-39451) 

▪ Fixed an issue where API-610 Annex F did not display on reports for equipment with only one failing 

nozzle among a pair of nozzles. (3812496) 

▪ Fixed an issue with an incorrect allowable stress value for the WRC 107 Pm+Pl+Q load case. (3682034) 

Output and Reports 

▪ Fixed an issue with Code Compliance Report filtering which affected report accuracy. (TR_TX-39236) 

▪ Fixed an issue with the Flange Peq Report where structural element nodes displayed even though 

flange checks do not apply to structural elements. (TR-TX-39796) 

▪ Fixed an issue with the Flange NC-3658.3 Report where the column formatting for AB was sometimes 

too narrow and displayed asterisks instead of data. (TR-TX-27894) 

▪ The software now formats static output reports to accommodate the displayed values, eliminating the 

display of multiple asterisks for a large value. (TR-TX-10671) 

▪ Fixed an issue with the Stresses Extended (Legacy) Report when using the DNV 2017 code. (TR-TX-

39792) 

▪ Fixed an issue with the Stresses Extended (Legacy) Report did not display user-specified values for in-

plane and out-of-plane SIFs when using the EN13480:17/A5:22 code. (3742103) 

▪ Fixed an issue where the Stresses Report used the incorrect data for B31.8 Chapter VIII combination 

load cases to display failures. (TR-TX-36704) 

▪ Fixed an issue where the Restraints Report incorrectly displayed large loads when the double-acting 

restraint with friction (such as X) was split into individual directions (such as +X and -X). (3537608) 
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▪ Added a note to stress and DNV reports to alert users that DNV-ST-F101 applies only to submarine 

pipeline systems and not to onshore pipeline systems. (2215856) 

▪ Fixed an issue where the controls of the Filters dialog > Line Numbers Tab of the Static Output 

Processor were not available. (3900732) 

▪ Fixed a B31J issue where a bend element reduced the length of the tee branch all the way to the surface 

of the header element, causing no display of data in the reports. (4089933) 

▪ Fixed an issue with B31J flexibility calculations when the special execution option Print Forces on Rigids 

and Expansion Joints is cleared, causing elements to be incorrectly filtered out from the reports. 

(4087647) 

External Interfaces 

▪ Fixed an issue where .pcf file import did not correctly import non-English or Unicode text on restraint 

tags. (TR-TX-33562) 

▪ Fixed an issue where the CAESAR II Data Matrix was not importing restraint data from a neutral file. 

(TR-TX-13985) 

▪ Fixed a node formatting issue that could cause a bend internal node number to use the To Node of the 

element after neutral file conversions into and then out of CAESAR II. (TR-TX-39317) 

▪ Fixed an issue with very small input forces or large negative input forces that caused the software to 

end when importing an .frc dynamic input file. (TR-TX-8629, TR-TX-16591, TR-TX-20875) 

▪ Added an error message regarding high memory allocation when exporting load cases to Excel in the 

Static Load Case Editor. (2737368) 

▪ In Import PCF and Advanced PCF Import (APCF), fixed an issue with duplicate elements from combined 

.pcf files creating large elements. (3244207) 

▪ Fixed an issue with negative node numbers in Advanced PCF Import (APCF) when importing a .pcf file 

into an existing CAESAR II model. (3675641) 

▪ Fixed issues with North, South, East, and West restraints related to the North Direction setting in 

Import PCF and Advanced PCF Import (APCF). (2560516) 

▪ Fixed an issue with incorrect mapping of direction cosines for Guide and LIM (limit stop) restraints when 

using the Data Export Wizard to export to Microsoft Access database files. (3577527) 

▪ Fixed an issue with missing data attributes in the text file created by the Data Export Wizard. (TR-TX-

39307) 

▪ Fixed naming and typographical issues with hanger and system units data when exporting model input 

to a text file in the Data Export Wizard. (3431757) 

▪ Fixed issues with missing data when exporting to a Microsoft Access file in the Data Export Wizard. 

(3987681, 3748248) 

Units 

▪ Fixed a conversion error for custom nozzle stiffness units in the Input Echo. (TR-TX-5184) 



 

10 

▪ Fixed an issue with Change Model Units causing incorrect model unit conversions if more than one 

conversion was chosen without closing the dialog. (TR-TX-36629) 

▪ Fixed a conversion error for the expansion coefficient of an API 650 flexible nozzle. (3584480) 
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Legal Notices 

Copyright 

© 1985-2023 Hexagon AB and/or its subsidiaries and affiliates. 

This computer program, including software, icons, graphic symbols, documentation, file formats, and audio-visual displays; may be used 

only as pursuant to applicable software license agreement; contains confidential and proprietary information of Intergraph Corporation or 

a Hexagon Group Company and/or third parties which is protected by patent, trademark, copyright law, trade secret law, and 

international treaty, and may not be provided or otherwise made available without proper authorization from Hexagon AB and/or its 

subsidiaries and affiliates. 

Contains RealDWG™ by Autodesk, Inc. Copyright © 1998-2023 Autodesk, Inc. All rights reserved. 

Portions of the user interface copyright © 2012-2023 Progress Software Corporation and/or its subsidiaries or affiliates. All Rights 

Reserved. 

U.S. Government Restricted Rights Legend 

Use, duplication, or disclosure by the government is subject to restrictions as set forth below. For civilian agencies: This was developed 

at private expense and is "restricted computer software" submitted with restricted rights in accordance with subparagraphs (a) through 

(d) of the Commercial Computer Software - Restricted Rights clause at 52.227-19 of the Federal Acquisition Regulations ("FAR") and its 

successors, and is unpublished and all rights are reserved under the copyright laws of the United States. For units of the Department of 

Defense ("DoD"): This is "commercial computer software" as defined at DFARS 252.227-7014 and the rights of the Government are as 

specified at DFARS 227.7202-3. 

Unpublished - rights reserved under the copyright laws of the United States. 

Intergraph Corporation, Hexagon’s Asset Lifecycle Intelligence Division  

305 Intergraph Way 

Madison, AL 35758 

Documentation 

Documentation shall mean, whether in electronic or printed form, User's Guides, Installation Guides, Reference Guides, Administrator's 

Guides, Customization Guides, Programmer's Guides, Configuration Guides and Help Guides delivered with a particular software 

product.  

Other Documentation 

Other Documentation shall mean, whether in electronic or printed form and delivered with software or on Intergraph Smart® Support, 

SharePoint, box.net, or the Hexagon documentation web site, any documentation related to work processes, workflows, and best 

practices that is provided by Hexagon as guidance for using a software product. 

Terms of Use 

a. Use of a software product and Documentation is subject to the End User License Agreement ("EULA") delivered with the software 

product unless the Licensee has a valid signed license for this software product with Intergraph Corporation, Hexagon’s Asset 

Lifecycle Intelligence Division (“Hexagon”), a Hexagon Group Company. If the Licensee has a valid signed license for this software 

product with Hexagon, the valid signed license shall take precedence and govern the use of this software product and 

Documentation. Subject to the terms contained within the applicable license agreement, Hexagon gives Licensee permission to 

print a reasonable number of copies of the Documentation as defined in the applicable license agreement and delivered with the 

software product for Licensee's internal, non-commercial use. The Documentation may not be printed for resale or redistribution. 

b. For use of Documentation or Other Documentation where end user does not receive a EULA or does not have a valid license 

agreement with Hexagon, Hexagon grants the Licensee a non-exclusive license to use the Documentation or Other Documentation 

for Licensee’s internal non-commercial use. Hexagon gives Licensee permission to print a reasonable number of copies of Other 

Documentation for Licensee’s internal, non-commercial use. The Other Documentation may not be printed for resale or 

redistribution. This license contained in this subsection b) may be terminated at any time and for any reason by Hexagon by giving 

written notice to Licensee. 
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Disclaimer of Warranties 

Except for any express warranties as may be stated in the EULA or separate license or separate terms and conditions, Hexagon 

disclaims any and all express or implied warranties including, but not limited to the implied warranties of merchantability and fitness for a 

particular purpose and nothing stated in, or implied by, this document or its contents shall be considered or deemed a modification or 

amendment of such disclaimer. Hexagon believes the information in this publication is accurate as of its publication date. 

The information and the software discussed in this document are subject to change without notice and are subject to applicable 

technical product descriptions. Hexagon is not responsible for any error that may appear in this document. 

The software, Documentation and Other Documentation discussed in this document are furnished under a license and may be used or 

copied only in accordance with the terms of this license. THE USER OF THE SOFTWARE IS EXPECTED TO MAKE THE FINAL 

EVALUATION AS TO THE USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.  

Hexagon is not responsible for the accuracy of delivered data including, but not limited to, catalog, reference and symbol data. Users 

should verify for themselves that the data is accurate and suitable for their project work.  

Limitation of Damages 

IN NO EVENT WILL HEXAGON BE LIABLE FOR ANY DIRECT, INDIRECT, CONSEQUENTIAL INCIDENTAL, SPECIAL, OR PUNITIVE 

DAMAGES, INCLUDING BUT NOT LIMITED TO, LOSS OF USE OR PRODUCTION, LOSS OF REVENUE OR PROFIT, LOSS OF 

DATA, OR CLAIMS OF THIRD PARTIES, EVEN IF HEXAGON HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  

UNDER NO CIRCUMSTANCES SHALL HEXAGON’S LIABILITY EXCEED THE AMOUNT THAT HEXAGON HAS BEEN PAID BY 

LICENSEE UNDER THIS AGREEMENT AT THE TIME THE CLAIM IS MADE. EXCEPT WHERE PROHIBITED BY APPLICABLE LAW, 

NO CLAIM, REGARDLESS OF FORM, ARISING OUT OF OR IN CONNECTION WITH THE SUBJECT MATTER OF THIS DOCUMENT 

MAY BE BROUGHT BY LICENSEE MORE THAN TWO (2) YEARS AFTER THE EVENT GIVING RISE TO THE CAUSE OF ACTION 

HAS OCCURRED.  

IF UNDER THE LAW RULED APPLICABLE ANY PART OF THIS SECTION IS INVALID, THEN HEXAGON LIMITS ITS LIABILITY TO 

THE MAXIMUM EXTENT ALLOWED BY SAID LAW. 

Export Controls 

Intergraph Corporation, Hexagon’s Asset Lifecycle Intelligence division (“Hexagon”), and a Hexagon Group Company’s software 

products and any third-party Software Products obtained from Hexagon, its subsidiaries, or distributors (including any Documentation, 

Other Documentation or technical data related to these products) are subject to the export control laws and regulations of the United 

States. Diversion contrary to U.S. law is prohibited. These Software Products, and the direct product thereof, must not be exported or re-

exported, directly or indirectly (including via remote access) under the following circumstances:  

a. To Cuba, Iran, North Korea, Syria or the Crimean, "Donetsk People's Republic", "Luhansk People's Republic", or Sevastopol 

regions of Ukraine, or any national of these countries.  

b. To any person or entity listed on any U.S. government denial list, including but not limited to, the U.S. Department of Commerce 

Denied Persons, Entities, and Unverified Lists, http://www.bis.doc.gov/complianceandenforcement/liststocheck.htm, the U.S. 

Department of Treasury Specially Designated Nationals List. Visit www.export.gov for more information or follow this link for the 

screening tool: https://legacy.export.gov/csl-search. 

c. To any entity when Licensee knows, or has reason to know, the end use of the Software Product is related to the design, 

development, production, or use of missiles, chemical, biological, or nuclear weapons, or other un-safeguarded or sensitive nuclear 

uses.  

d. To any entity when Licensee knows, or has reason to know, that an illegal reshipment will take place.  

Any questions regarding export/re-export of relevant Hexagon software product, customized software, Technical Data and/or third-party 

software obtained from Hexagon, its subsidiaries or distributors, should be addressed to Hexagon’s Export Compliance Department, 305 

Intergraph Way, Madison, Alabama 35758 USA or at exportcompliance@intergraph.com. Customer shall hold harmless and indemnify 

Hexagon and a Hexagon Group Company for any causes of action, claims, costs, expenses and/or damages resulting to Hexagon or a 

Hexagon Group Company from a breach by Customer. 

Trademarks 

Intergraph®, the Intergraph logo®, Intergraph Smart®, SmartPlant®, SmartMarine, SmartSketch®, SmartPlant Cloud®, PDS®, 

FrameWorks®, I-Route, I-Export, ISOGEN®, SPOOLGEN, SupportManager®, SupportModeler®, SAPPHIRE®, TANK, PV Elite®, 

CADWorx®, CADWorx DraftPro®, GTSTRUDL®, CAESAR II®, and HxGN SDx® are trademarks or registered trademarks of Intergraph 

Corporation or its affiliates, parents, subsidiaries. Hexagon and the Hexagon logo are registered trademarks of Hexagon AB or its 

subsidiaries. Other brands and product names are trademarks of their respective owners. 

The following are trademarks and service marks owned by Intergraph Corporation d/b/a Hexagon or its subsidiaries worldwide: 

hexagonppm.com/trademarks. 

https://hexagonppm.com/trademarks

